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MapGuide Maestro 
(Version 1.0.9.15910) 
Aide V 1.02 (débutant)
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MapGuide Maestro est la version OS du logiciel Studio, qui permet l’édition de cartes MapGuide. 
On peut personnaliser nos cartes en ajoutant différents calques traitant des ressources provenant de diverses sources de données (vectorielles, matricielles, base de données, etc.).

Voici les différentes étapes pour créer un SIG basique :

1 Connexion au serveur

Il faut tout d’abord rentrer l’adresse du serveur ainsi que les identifiants de connexion :
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Normalement l’adresse de connexion au site est la même que celle décrite dans l’image ci-dessus, si les paramètres de configuration initiale (installation n’ont pas été changés).

Username : Administrator

Password : admin

2 structurations des données 
Dans une logique de gestion il est nécessaire de créer trois répertoires dans l’arborescence de MapGuide  

[image: image30.png]Edit Packages Help
New

Open Cul+0.
R Close Cul+Fd
O sme CHles
O s

Swveall  CtieMajsS

Edit 25 Xml

Save as Xl

Load from Xml.

= Folder

& Dataconnection
Fusion Application




Le premier du nom de la carte à réaliser dans l’exemple DEP

Le deuxième  du nom de Calque  (ou sera sauvegarder les calques)
Le troisième  du nom de Données (ou sera sauvegarder la connexion aux données)
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Pour cela clique doit sur l’arborescence et créer les nouveaux répertoires.
Répéter  l’opération dans le répertoire créé pour avoir l’arborescence suivante 
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3 Ajout d’une ressource 

a) De type vectoriel (pour l’exemple shape *.dhp)
File → New → Dataconnexion 
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choisir OSGeo FDO Provider for SHP. 

Cliquez sur [image: image2.jpg]


  en dessous de file location, choisissez votre fichier Shape 
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Vous pouvez ajouter plusieurs fichiers Shape dans une même ressource en réitérant le procédé ci-dessus autant de fois que le nombre de fichiers Shape que vous voulez ajouter.
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Sauvegardez ctrl+s, vous pouvez maintenant utiliser cette ressource ou fichier enregistrer sous le répertoire Donnée
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Pour les données non manager par MapGuide si dans le module d’administration vous avez créé des alias sur vos données 
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La connexion aux données est la suivante 
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Ne pas oublier de tester la liaison aux données  

[image: image6.png]Cick on "Test connection” o test wth the curent parameters.

Test connection




Définir le system de projection des données origine et de destination 

[image: image7.png]Edit coordinate system override

Source
Target

0o|.




 
et ….
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b) Les données de type Raster
Le principe est à peu près le même que pour les images vectorielles : File → New → Dataconnexion et choisir OSGeo FDO Provider for GDAL ou FDO Provider for Raster (selon la version de FDO).
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Pour ce tutorial on utilisera le type composite à droite de type des différences existent entre les deux, j’ai cru comprendre que Single file or folder était plus rapide quand il y avait un grand nombre de rasters.

Cliquez sur [image: image9.jpg]


  en dessous de type, choisissez votre fichier Raster. Cliquez sur « Ok ». Cliquez ensuite sur « Test connexion » pour voir si tout fonctionne bien au niveau de vos images Raster.
ATTENTION : Le chemin d’accès aux fichiers Raster ne doit pas comporter de caractères spéciaux sinon le fichier image ne se chargera pas.
ATTENTION2 : Pour les images Raster on utilise la bibliothèque GDAL des FDO (Feature Data Object), dans mon cas le chargement ne marchais qu’avec une version de GDAL (3.4.0) si vous rencontrez des problèmes pour le chargement d’image Raster essayez d’utiliser une autre version de la bibliothèque. 

c) Jointure entre table et calcul de la géométrie des objets (surface et linéaire)
Il est possible à partir d’une liaison aux données de faire une jointure soir à une base spatiale existante, soit à une base de type DBF ou MDB ayant un identifiant identique. Pour cela :
Sur la panneau de connexion aux données cliquez sur ( édit extensions)
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Et ensuite créer la liaison 

[image: image39.png]@ voe o T S e

I
=l
|

adresses
archives
archives |
o3l
espaces
Nom des
Reseau €
sauvegan
test

CCCCCCOCL

[adressesti
larchives

| erchives parcslepropio || eclarageT s

losi
| espaces vets
] Nom des e

| Reseau EUEP-EAU lplan espace verts 2007scf

lseuvegarde
Cltest
labresscf

| ARMOIRE scf
[ candelabre.scf

[l chambre_EP st
[ eclarage scf

[ Jime-proro scf
[ parceleproprio s

[ parcele s

[ plan des arbres 2007 scf

 RESEAUECsS
lsauve eclaage sdf
ltrensfoEPsdt
Dlvoinesdt
Dlarfuamole st

o [5DF]
Fietype. (SDF Fies ¢se)




[image: image40.png]


[image: image11.png]CETEREREE | RN 2 —cka

BBA|s

7 i2kgn 2 ure ourebose

Join name -
nesses ol /OAU Dk e ()

Featureclass

Jontype

[ Force oneo-one relation





[image: image41.png]



Pour le point 3 choisissez la base à lier  
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 Choisissez les clés de liaison entre les deux bases
[image: image13.bmp]Le calcul de la géométrie des objets (surface et linéaire) est sur le même tableau 

Exemple pour une surface

[image: image14.png]a Edit feature source extensions

- o~

- = = .

X886
BR ] oo iccuioce]

7 RedineCaled

Bdension name

Feature class to axtend

caloul de sufaces




Et ensuite 
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Pour une distance
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3 Création d’un calque (Layer)
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Ce calque sera créé  dans le répertoire  Calque :

Pour cela File → New → Layer.
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Il faut cliquer sur les 3 points pour sélectionner une ressource, celles que vous avez sauvegardé dans l’étape 3 devraient apparaître.
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Suite à cela 

[image: image18.png]



Feature resource : donne la librairie de la ressource ( dans notre cas adresse)

Resource settings Schema désigne le schéma à utiliser 

ATTENTION : C’est ici que on choisira la jointure entre les tables ou la jointure au calcul des géométries d’objets de type ligne et polygone 
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Dans l’exemple ci-dessus je cherche la jointure Fdo :Schéma :calcul de surface qui me donnera la surface de mes polygones dans la variable RedlineCalcul
Geometry toujours pour ce type de données comme la capture suivante 
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les éléments suivant sont : le filtre au données visible 
la génération d’hyperliens en fonction des données de la ou des tables 

la génération d’info bulle (tooltip) 

un soin particulier est à apporter à la syntaxe dans le générateur de syntaxe qui est identique pour ces trois éléments. C'est-à-dire avec la même type de syntaxe. Le générateur de syntaxe se déclanche en cliquant sur les trois petit point  
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dans l’exemple ci-dessus je concat une expression fixe ‘Surface=’ avec une variable RedlineCalcul et une autre expression fixe qui est l’unité de mesure ‘M²’

cela donne quand la sourie passe sur le polygone 

Surface=100.20 M² dans une info bulle et cela à partir de la géométrie d’objet calculée.

Vous notez le fonction concat qui rassemble deux valeurs dans une expression et la fonction Round qui retourne la valeur arrondie à deux décimale de ma surface.
Certaine compatible que avec les FDO version 3.3 

Le menu déroulant select colum permet d’insérer des champs de la liaison FDO dans le générateur  d’expressions
Liste des fonctions dans le générateur    sources Autodesk 
Lorsque vous créez une expression pour des objets géospatiaux, vous pouvez faire appel aux fonctions mathématiques suivantes. 

	Fonction
	Définition
	Syntaxe
	Exemple

	ABS
	Renvoie la valeur absolue d'un nombre (sans son signe) à l'aide du type de données d'entrée. 

Par exemple, ABS(-2)=2
	ABS(Propriété_numérique)
	ABS(Angle_canalisation)

	ACOS
	Renvoie le cosinus d'arc, ou cosinus inversé, d'un nombre compris entre ou égal à -1 et 1. (Il s'agit de l'angle dont un cosinus est égal à un nombre donné.) La valeur renvoyée est exprimée en radians, avec un type de données Double. 

Par exemple, ACOS(.5)=pi/3 
	ACOS(Propriété_numérique)
	ACOS(Propriété_canalisation)

	ASIN
	Renvoie le sinus d'arc, ou sinus inversé, d'un nombre compris entre ou égal à -1 et 1. (Il s'agit de l'angle dont un sinus est égal à un nombre donné.) La valeur renvoyée est exprimée en radians, avec un type de données Double.

Par exemple, ASIN(.5)=pi/6 
	ASIN(Propriété_numérique)
	ASIN(Propriété_canalisation)

	ATAN
	Renvoie la tangente d'arc, ou tangente inversée, d'un nombre. (Il s'agit de l'angle dont une tangente est égale à un nombre donné.) La valeur renvoyée est exprimée en radians, avec un type de données Double.

Par exemple, ATAN(1)=pi/4
	ATAN(Propriété_numérique)
	ATAN(Propriété_canalisation)

	ATAN2
	Retourne la tangente d'arc, ou tangente inversée, des coordonnées X et Y d'un point. Chaque coordonnée peut être un nombre réel quelconque. La valeur renvoyée est exprimée en radians, avec un type de données Double.

Par exemple, ATAN2(-.7071,.7071)=3pi/4
	ATAN2(x_propriété_numérique, y_propriété_numérique)
	ATAN2(NS_propriété_rue, EO_propriété_rue)

	COS
	Renvoie le cosinus d'un angle. La valeur renvoyée a un type de données Double. (Dans un triangle rectangle, le cosinus d'un angle correspond au rapport du côté adjacent à l'hypoténuse.)

Par exemple, COS(pi/3)=.5
	COS(Propriété_angle)
	COS(Angle_canalisation)

	EXP
	EXP renvoie e élevé à la puissance spécifiée, où e = 2.71828183 ... 

EXP renvoie une valeur avec un type de données Double.

Par exemple, EXP(2)=7.389056099...
	EXP(Propriété_numérique)
	EXP(Propriété_longueur_rue)

	LN
	Renvoie le logarithme naturel d'un nombre positif. La valeur renvoyée a un type de données Double. L'algorithme naturel sert souvent à déterminer le temps nécessaire pour atteindre un niveau donné. 

Par exemple, LN(2.71828183)=1
	LN(Propriété_numérique)
	LN(Propriété_niveau_voulu)

	LOG
	Renvoie le logarithme, dans la base spécifiée, d'un nombre. La valeur renvoyée a un type de données Double. La base peut être toute valeur positive autre que 1 et le nombre peut être n'importe quelle valeur positive.

Par exemple, LOG(10,100)=2
	LOG(Base, Propriété_numérique)
	LOG(10,Propriété_coût)

	MOD
	Renvoie le reste de la division d'un nombre (le dividende) par un autre nombre (le diviseur). 

Par exemple, MOD(11,4)=3
Calcule l'arrondi avec la fonction FLOOR. Pour plus d'informations, reportez-vous à la section Utilisation des fonctions Mod et Remainder. 
	MOD(Dividende, Diviseur)
	MOD(Valeur_parcelle, Superficie_parcelle)

	POWER
	Renvoie le résultat d'un nombre élevé à la puissance d'un second nombre. La valeur renvoyée a un type de données Double. 

La base et l'exposant peuvent être des nombres, quelconques, mais si la base est négative, la puissance doit être un entier.

Par exemple, POWER(5,2)=25
	POWER(Nombre_base,Nombre_puissance)
	POWER(Coût_parcelle,2)

	REMAINDER
	Renvoie le reste de la division d'un nombre par un autre nombre.

Par exemple, REMAINDER(11,4)=-1
Calcule l'arrondi avec la fonction ROUND. Pour plus d'informations, voir Utilisation des fonctions Mod et Remainder.
	REMAINDER(Dividende, Diviseur) 
	REMAINDER(Coût_parcelle,4)

	SIN
	Renvoie le sinus d'un angle. La valeur renvoyée a un type de données Double. Dans un triangle rectangle, le sinus d'un angle correspond au rapport du côté opposé de l'hypoténuse.

Par exemple, SIN(pi/6)=.5
	SIN(Propriété_angle)
	SIN(Angle_canalisation)

	SQRT
	Renvoie la racine carrée d'un nombre positif. La valeur renvoyée a un type de données Double. 

Par exemple, SQRT(25)=5
	SQRT(Propriété_numérique)
	SQRT(Superficie_parcelle)

	TAN
	Renvoie la tangente d'un angle. La valeur renvoyée a un type de données Double. Dans un triangle rectangle, TAN est le rapport du côté opposé au côté adjacent.

Par exemple, TAN(pi/4)=1
	TAN(Propriété_angle)
	TAN(Angle_canalisation)


Options de conversion
	Option
	Définition
	Syntaxe
	Exemple

	NULVALUE
	Evalue deux propriétés. Si la première n'a pas la valeur Null, NULLVALUE renvoie la valeur de cette propriété. Dans le cas contraire, NULLVALUE renvoie la valeur de la seconde propriété. 
	NULLVALUE(Propriété_texte, valeur)
	NullValue(Propriétaire_parcelle,'Aucun propriétaire répertorié')
Dans cet exemple, NULLVALUE évalue la valeur de Propriétaire_parcelle. Si elle a la valeur Null, elle convertit cette valeur en chaîne "Aucun propriétaire répertorié". S'il existe une valeur pour Propriétaire_parcelle, elle la renvoie.

	TODATE
	Convertit une chaîne de texte représentant des informations de date/d'heure en objet de date. La valeur renvoyée a un type de données DateHeure.

La propriété de texte fournie doit correspondre au format fourni. Si tel n'est pas le cas, la conversion n'a pas lieu.

Voir Options de format de date. 
	TODATE(Propriété_texte,format)
	TODATE(Date_achat,MM/JJ/AAAA)
Dans cet exemple, la valeur de date d'achat est convertie en valeur de date au format MM/JJ/AAAA. Si la valeur de date d'achat est le 2 novembre 2002, elle sera convertie en 11/02/2002.

	TODOUBLE
	Convertit un nombre ou une chaîne de texte en nombre décimal à double précision.
	TODOUBLE(Propriété_texte)
	TODOUBLE(Valeur_parcelle)
Dans cet exemple, la valeur Valeur_parcelle est convertie en chaîne de texte.

	TOFLOAT
	Convertit un nombre ou une chaîne de texte en nombre décimal à simple précision.
	TOFLOAT(Propriété_texte)
	TOFLOAT(Valeur_parcelle)
Dans cet exemple, la valeur Valeur_parcelle est convertie en chaîne.

	TOINT32
	Convertit une expression numérique ou de chaîne en entier int32.
	TOINT32(Propriété_texte)
	  

	TOINT64
	Convertit une expression numérique ou de chaîne en entier int64.
	TOINT64(Propriété_texte)
	  

	TOSTRING
	Convertit une expression numérique ou de date en une chaîne grâce à un format facultatif que vous spécifiez 

ou 

Convertit une propriété numérique en chaîne de texte (aucun format ne peut être attribué).

Voir Options de format de date pour les options de format.
	TOSTRING(Propriété_date, format) 

ou 

TOSTRING(Propriété_numérique)
	TOSTRING(Date_vente_parcelle,MM/JJ/AAAA)
Dans cet exemple, si la valeur de Date_vente_parcelle est le 12 janvier 2007, elle est convertie en chaîne de texte 01/12/2007.


Fonctions de date
	Fonction
	Définition
	Syntaxe
	Exemple

	ADDMONTHS
	Trouve le résultat de l'ajout de mois à une date. La valeur de la propriété fournie doit être un entier. Renvoie une chaîne de type de données DateHeure au format de la valeur de date d'origine.
	ADDMONTHS(Propriété_date, Nombre)
	ADD_MONTHS(Date_début,1)
Cet exemple ajoute un mois à la valeur de Date_début. Si Date_début est le 1er juin 2008, ADDMONTHS renvoie le 1er juillet 2008.

	CURRENTDATE
	Renvoie la date du jour sous la forme d'une chaîne avec un type de données DateHeure.
	CURRENTDATE( )
	CURRENTDATE ( )

	EXTRACT
	Extrait un champ date/heure d'une valeur de date/heure. Renvoie une valeur du calendrier grégorien avec un type de données DateHeure. Le champ date/heure peut être 'ANNEE', 'MOIS', 'JOUR', 'HEURE', 'MINUTE' ou 'SECONDE'.
	EXTRACT(champ, Propriété_date)
	EXTRACT(ANNEE,Date_début)
Cet exemple extrait l'année de la valeur de Date_début. Si Date_début est le 1er juin 2008, EXTRACT renvoie 2008.

	MONTHSBETWEEN
	Renvoie le nombre de mois entre deux dates en tant que type de données Double. Si la première date est ultérieure à la seconde, le résultat est positif. Si la première date est antérieure à la seconde, le résultat est négatif. Si les deux dates correspondent au même jour d'un mois ou au dernier jour d'un mois, le résultat est un entier. Si tel n'est pas le cas, il s'agit de la fraction du résultat basée sur un mois de 31 jours.
	MONTHSBETWEEN(Propriété_date,Propriété_date)
	MONTHSBETWEEN(Date_début, Date_fin)
Dans cet exemple, si Date_début est le 1er mars 2007 et Date_fin le 1er avril 2007, MONTHSBETWEEN renvoie 1.


Fonctions numériques
	Fonction
	Définition
	Syntaxe
	Exemple

	CEIL
	Arrondit un nombre à l'entier supérieur le plus proche. La valeur renvoyée fait appel au type de données d'entrée.

Par exemple, CEIL(2.6)=3
CEIL(-2.6)=-2
	CEIL(Propriété_numérique)
	CEIL(Coût_part)

	FLOOR
	Arrondit un nombre à l'entier inférieur le plus proche. La valeur renvoyée fait appel au type de données d'entrée.

Par exemple, FLOOR(2.6)=2
FLOOR(-2.6)=-3
	FLOOR(Propriété_numérique)
	FLOOR(Coût_part)

	ROUND
	Arrondit un nombre aux décimales spécifiées. La valeur renvoyée fait appel au type de données d'entrée.

Par exemple, ROUND(1.476,2)=1.48
	ROUND(Propriété_numérique, Nombre de décimales)
	ROUND(Coût_part,2)

	SIGN
	Trouve le signe d'un nombre. Renvoie 1 si le nombre est positif, 0 si le nombre est 0, -1 si le nombre est négatif. La valeur renvoyée fait appel au type de données Int16.

Par exemple, SIGN(-3.76)=-1
	SIGN(Propriété_numérique)
	SIGN(Profit_vente_parcelle)

	TRUNC
	Tronque une propriété de date au format spécifié ('ANNEE', 'MOIS', 'JOUR', 'HEURE' ou 'MINUTE') 

ou 

Tronque une propriété numérique au nombre de décimales spécifié. La valeur renvoyée fait appel au type de données d'entrée.

Par exemple, TRUNC(1.476, 2)=1.47
Cette fonction renvoie un DOUBLE.
	TRUNC(Propriété_date, 'Format')
TRUNC(Propriété_numérique, Nombre de décimales)
	TRUNC(Date_réparation, 'JOUR')
ou

TRUNC(Coût


Options géométriques
Pour utiliser ces options, sélectionnez l'objet dont vous voulez connaître la longueur ou la superficie, puis créez l'expression exactement comme indiqué dans l'exemple ci-dessous. Ne remplacez pas l'argumentGéométrie par une valeur.

	Option
	Définition
	Syntaxe
	Exemple

	LENGTH2D
	Calcule la longueur des lignes et les périmètres des polygones.
	LENGTH2D(Géométrie)
	LENGTH2D(Géométrie)

	AREA2D
	Calcule la superficie d'un polygone.
	AREA2D(Géométrie)
	AREA2D(Géométrie)


Donc ces fonctions dans l’éditeur contrôlent directement les éléments suivants : 
· Filtrage d'un calque (un calque) 

· Création de règles de stylisation 

· Spécification de l'étiquette d'objet à afficher 

· Définition de la taille de police, de l'alignement et de la rotation d'une d'étiquette 

· Définition de la taille, de la rotation et de la largeur de bordure d'un symbole 

· Définition de la largeur de ligne 

· Définition de la largeur de bordure d'un polygone 

· Définition des paramètres d'annotation 

· Création de propriétés calculées 

· Définition de l'info-bulle MG Viewer sur des objets 

· Définition de l'URL MG Viewer sur des objets
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Exemple de fonction texte
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Sélectionnez les éléments que vous souhaitez voir afficher lors de la consultation de l’objet. Il est possible de renommer dans la colonne Display le nom du champ de façon plus éloquente   

La stylisation des données (le rendu visuel) dans la couche de donnée 
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Dans sa partie gauche vous définissez la plage d’échelle de votre objet et son type d’affichage 

Dans la capture ci-dessus de 200 à 4999 la règle d’affichage est la suivante pour un objet de type point. 
De 200 à 4999 afficher le numéro du point « NUM_POINT »  NOTEZ un BUG sur Feature style la valeur est à None car Maetro n’arrive pas à lire la symbolique qui est un fichier bipmap représentant un logo grrrrr . dans ma bibliothèque d’objet  [image: image23.bmp]
 De 5000 à 15000 afficher le point comme une simple rond jaune mais pas de Lablel style
(c’est simple non ;-) ) 
Donc une petite sauvegarde dans la répertoire calque….hé oui ne pas oublier…
Et ensuite degarde votre beau travail dans votre navigateur en cliquant sur le symbole 
De 200 à 4999  [image: image24.png]


 de 5000 à 15000 [image: image25.png]


(échelle 7000)
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2 Création d’une carte (Map)
File → New → Map, il faut tout d’abord ajouter des calques en cliquant sur le [image: image28.jpg]


 afin de choisir les calques crées précédemment.
Une fois tous les calques ajoutés cliquez sur « Set view to current layers extent », cela permettra de définir automatiquement la vue initiale de la carte centrée.

Sauvegardez.
3 Création d’un WebLayout
File → New → Layout, il faut choisir la carte que l’on a crée à l’étape 4 (Map Resource).
4 Test

Cliquez sur « Show in browser » dans le WebLayout crée précédemment.

5 Sauvegarde et chargement d’un package .mgp

Sauvegarde

Une fois la carte terminée il est possible de la sauvegarder dans une archive pour pouvoir la réutiliser ultérieurement.

Pour cela : Package → Create Package et cocher les informations voulues ainsi que le fichier de sortie dans le répertoire des packages (MapGuide\Packages).
ATTENTION : Pour sauvegarder votre package il faut que tous les fichiers (layers, maps, etc.) se trouvent dans un dossier cat il n’est pas possible d’exporter directement Library://, dans cette version le fait d’exporter Library:// fait crasher l’application.
Chargement

Le chargement à partir de Maestro fait crasher l’application, cependant il est possible de le charger à partir de : http://localhost:8008//mapguide/mapadmin/packagemanagement.php (avec les paramètres par défaut). 

Choisissez ensuite dans le menu Tools → Site Administrator entrez vos identifiants (cf. au dessus : 1. connexion au serveur), cliquez sur manage packages et charger le package souhaité.
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